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Lyhenteet 

JDK Java Development Kit. Javan ohjelmistokehityspaketti. 

Red5 Red5 on mediapalvelin, joka on tarkoitettu videon suoratoistoa varten. 

Pilvipalvelu Palvelu joka tarjotaan etäkoneelta. 

SaaS Software as a Service. Pilvilaskennanmalli jossa ohjelmisto tarjotaan pal-

veluna 

Instanssi Pilvipalvelussa instanssi tarkoittaa yksittäistä virtuaalista palvelinta pilviver-

kossa. 

IIS Internet Information Services. Web-palvelinohjelmisto, jota käytetään Win-

dows-pohjaisissa palvelimissa. 

DOM Document Object Model. Järjestelmäriippumaton ohjelmointirajapinta, jolla 

voidaan kuvata eri dokumenttien rakenne puuna, jossa jokainen solmu esi-

tetään oliona. 

JSP Java Server Pages. Javaan perustuva teknologia, jonka avulla luodaan dy-

naamisia web-sivuja käyttäen mm. HTML:ää ja XML:ää. 

CSS Cascading Style Sheets. Kieli joka kuvaa tyylin jolla HTML-elementit esite-

tään 

Paytrail Verkkomaksamiseen käytetty palvelu 

Bootstrap Verkkosivujen suunnitteluun tarkoitettu kehys, jonka on suunnattu pääasi-

allisesti mobiililaitteiden skaalautuvaan näkymään. 

MD5 Kryptografiassa (salakirjoitustekniikka) käytetty algoritmi, jolla syötteestä 

tehdään tiiviste. 

MySQL Relaatiotietokantaohjelmisto 
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1 Johdanto 

Työ sisältää kuvauksen ohjelman toiminnasta, ohjeet työympäristön asentamiseen sekä 

testipalvelimen pystyttämiseen. Lopuksi käydään läpi jatkokehityksen aikana tehtyjä 

muutoksia. 

Sovellus on ikäihmisille suunnattu muistojen tallennusverkkopalvelu. Palvelua voidaan 

käyttää tietokoneella sekä tabletilla. Se on SaaS-pohjainen sovellus, jossa on käytetty 

Spring MVC-sovelluskehystä sekä Red5-mediapalvelinta. 

Alun perin ohjelma on teetetty intialaisella ohjelmistoalihankkijalla. Ohjelmistotyötä ovat 

aiemmin jatkaneet useat eri ohjelmoijat. Minut palkattiin tekemään uusi käyttöliittymä 

sekä verkkokauppa sovellukseen. Sovelluksen nimeä ei mainita työssä, koska se on 

pyydetty pitämään salassa. 

Uusi käyttöliittymä tehtiin yhteistyössä graafisen suunnittelijan kanssa. Saadakseni käyt-

töliittymästä halutun näköisen jouduin muuttamaan logiikkaa, jolla tarinat piirrettiin näky-

mään. Verkkokaupan tekeminen jäi kesken, mutta siitä on tehty suunnitelma. Verkko-

maksupalveluna tullaan käyttämään Paytrail:ia. Työssä käydään läpi, miten Paytrail-

maksutapahtuma toteutetaan. 

2 Sovellus 

Palvelu on verkkopalvelu muistojen tallentamista varten. Tarinoita voidaan tallentaa 

teksti-, kuva-, ääni- sekä videomuodossa. Video- ja äänitarinat voidaan nauhoittaa suo-

raan palveluun käyttäen web-kameraa ja mikrofonilla, tai vaihtoehtoisesti ladata tiedostot 

tietokoneelta. Käyttäjä voi jakaa tarinansa julkisesti kaikkien nähtäväksi. Halutessaan 

käyttäjä voi kuitenkin pitää tarinansa yksityisenä tai erikseen luodun yhteisön kesken. 

Tarinoiden selaamiseen on olemassa kaksi erilaista näkymää: Aikajananäkymä, jossa 

tarinoita selataan aikajanaa pitkin kolmiulotteisessa näkymässä, sekä kartta-näkymä 

jossa tarinat on sijoitettu kartalle. 
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Sovellus on suunnattu pääasiallisesti ikäihmisille, joten ohjelman toiminta on pyritty pitä-

mään mahdollisimman selkeänä ja fonttikoko suurena. 

Taulukko 1. Käytetyt kolmannen osapuolen tekniikat 

Teknologia Kuvaus 

Java Ohjelmointikieli. Sovelluksessa käytetty 

pääasiallinen ohjelmointikieli. 

Java EE Java Platform, Enterprice Edition. Alusta 

java-kehitystä varten, joka tarjoaa verk-

koon liittyviä työkaluja. 

HTML5 Hypertext Markup Language. Käytetään 

internetsivujen luontiin. 

CSS Cascading Style Sheet. HTML-sivujen 

tyylin muotoilukieli. 

Javascript Ohjelmointikieli jolla voidaan lisätä dynaa-

mista toiminnallisuutta web-sivuihin 

jQuery Javascript-kirjasto, jota käytetään mm. 

DOM-elementtien käsittelyssä. 
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three.js Javascript-kirjasto, jota käytetään 3D-ani-

maation esittämisessä. Sovelluksen tari-

naelementit piirrettiin käyttäen three.js-

kirjastoa. 

Bootstrap Sovelluskehys jota käytetään responsiivi-

sien sivujen luonnissa. Monissa sovelluk-

sen painikkeissa käytettiin tätä tekniikkaa, 

jotta ne saataisiin uudelleen järjesteltyä 

erikokoisissa näkymissä. 

Spring  Spring on sovelluskehys, jonka avulla voi-

daan yhdistää eri systeemejä toisiinsa. 

Hibernate  Hibernate on java-pohjainen sovelluske-

hys, jota käytetään olioiden kartoittami-

seen 

JSP Java Server Pages on teknologia, jolla 

web-sivu yhdistetään tietokantaan. 

JSTL JSTL on JSP:n avainsana kirjasto, joka si-

sältää mm. XML ja SQL tageja.  

Red5 Red5 on median suoratoisto palvelin. 

Tätä palvelinta käytettiin sovelluksen 

käynnistämiseen. 
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Maven Maven on työkalu, jolla projektin rakenta-

minen automatisoidaan. 

HDFVR Verkossa sivulla toimiva sovellus, jolla 

voidaan nauhoittaa video web-kameraa 

käyttäen suoraan palvelimelle. 

Sovelluksen rakenne on kuvattu tarkemmin edeltävissä dokumenteissa. [1.] [2.] 

3 Työympäristön asennus 

3.1 JDK:n asennus 

Työympäristön asennus aloitettiin lataamalla JDK (Java Development Kit). Sen jälkeen 

ympäristömuuttujiin lisättiin JAVA_HOME ja määriteltiin sen arvoksi hakemisto, johon 

JDK asennettiin. 

1. Hiiren oikealla Tietokoneesta > Ominaisuudet > Järjestelmän lisäasetukset > Ym-

päristömuuttujat. 

2. Lisätään järjestelmämuuttujiin uusi muuttuja nimeltä JAVA_HOME ja määritetään 

sen arvoksi polku hakemistoon, johon JDK on asennettu. 
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Kuva 1 Ympäristömuuttujat 

3. Sovelluksen ohjelmointi tapahtui käyttäen Eclipse-IDE työympäristöä. Ladataan 

Eclipse ja käynnistetään se. 

4. Asetetaan java-kääntäjäksi juuri ladattu JDK. Window>Preferences>Java>In-

stalled JREs> JDK 

 

3.2 Projekti Eclipseen 

1. Projekti ladattiin gitlabista ”git clone” -komennon avulla. Sen jälkeen projekti tuo-

tiin Eclipseen. 

2. File > Import…> Existing Maven Projects 
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Kuva 2 Projektin tuonti Eclipseen 

3. Juurihakemistoksi valittiin gitlabista ladattu projekti, jonka jälkeen pom.xml-nimi-

nen tiedosto ruksattiin ja lopuksi painettiin ”Finish”-painiketta. 

 

4. Projektia varten tarvittiin myös muutamia kirjastoja, joita varten projektin juureen 

lisättiin ”lib”-kansio.  

 

5. Project > Properties > Java Build Path. Jossa sitten lisättiin tarvittavat kirjastot 

ja poistettiin virheelliset kirjastot. 

 

6. Mikäli projektissa esiintyi ”Maven depencies”-virheitä, niin nämä saatiin poistet-

tua päivittämällä. 

 

 

7. Hiiren oikealla projektista > Maven > Update project…> Ok 

 

3.3 Koontiversion luonti 

Ohjelmistosta luotiin koontiversio, jotta projekti saatiin toimimaan Red5-palvelimella. 

1. Hiiren oikealla projektista > Run As > 6 Maven Build  
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Kuva 3 Koontiversion luonti Eclipsessä 

2. Tavoitteeksi asetettiin ”clean package install” ja painettiin ”Run”. 

3.  Projektin target kansioon luotiin WAR-tiedosto sekä projektin ROOT-kansio, joka 

sitten vietiin Red5-palvelimelle. 

4. Red5-serverin webapps-kansiosta poistettiin valmiina oleva ROOT-kansio ja kor-

vattiin se aikaisemmin luodulla ROOT-kansiolla. 

5.  Palvelin käynnistettiin red5-juurihakemistossa sijaitsevasta red5.bat-tiedostosta. 

Sovelluksen näkyy osoitteessa http://localhost:5080, mikäli portti 5080 on avattu 

palomuurin asetuksista.  
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4 Testipalvelimen pystyttäminen 

Ohjelmiston kehittämistä ja testaamista varten luotiin uusi testipalvelin. Uudella testipal-

velimella on tarkoitus testata sovelluksen uuden version testaamista, ennen kuin se vie-

dään julkiselle palvelimelle. Edeltävällä testipalvelimella oleva versio on jatkuvan kehi-

tyksen alaisena, joten se ei ollut optimaalinen testaamiseen. 

4.1 Etäkoneen pystyttäminen 

Aluksi Amazonin pilvipalveluun luotiin uusi instanssi. Instanssin luonnin yhteydessä la-

dattiin tiedosto, joka sisälsi etäkoneen ip-osoitteen ja salasanan. Tarvittavat portit lisättiin 

saapuviin sääntöihin (inbound rules), jotta etäkoneelle päästään kirjautumaan omalta 

koneelta etätyöpöytäyhteyden avulla. 

4.2 Red5:n asennus 

 Red5-mediapalvelimesta ladattiin versio 1.07, sillä se muissa versioissa näytti olevan 

ongelmia sovelluksen kanssa. Red5:n webapps-kansioon lisättiin web-kameravideon 

nauhoitussovellus HDFVR. Olemassa oleva ROOT-kansio korvattiin Eclipsessä luodulla 

ROOT-kansiolla. 

4.3 MySQL:n asennus 

Tietokantaa varten ladattiin MySQL-Installer, josta saatiin helposti asennettua MySQL-

toimintaa varten tarvittavat komponentit. Asennettaviin komponentteihin kuuluivat 

MySQL Server, MySQL Connector ja MySQL Workbench. 

Asennuksen yhteydessä pyydettiin määrittelemään root-tunnuksen salasana. Red5-pal-

velimella sijaitsevassa dispatcher-servlet.xml-nimisessä tiedostossa määritellään tieto-

kannan tunnukset. Mikäli tiedostossa on eri tunnukset kuin ne, jotka määriteltiin aiemmin, 

niin tulee ne muuttaa. 

Tietokannan luontiin käytettiin skriptitiedostoa.  
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1. Avataan MySQL Workbench. 

2.  Luodaan yhteys tietokantaan. Database > Connect to Database > Syötä käyttä-

jätunnus ja salasana.  

3. Ajetaan skriptitiedosto. File > Run SQL Script… > Valitse skripti tiedosto > Run. 

 

4.4 IIS:n asennus 

Palomuurin asetuksista avattiin tarvittavat portit sovelluksen käyttöä varten. Tämän jäl-

keen asennettiin IIS (Internet Information Services) manager. 

1. Ohjauspaneeli > Ohjelmat > Ota Windows ominaisuuksia käyttöön tai poista niitä 

käytöstä > Valitse IIS > OK. 

2. Hiiren oikealla tietokoneesta > hallitse > Tools > IIS-palveluiden hallinta 

Palvelua varten tarvittiin varmenne. Testipalvelimen käyttöä varten riitti, että luotiin itse 

allekirjoitettu varmenne. 

3. Kun ollaan IIS-palveluiden hallinnassa, kaksoisnäpäytetään localhost > Palvelin-

varmenteet > Luodaan itse allekirjoitettu varmenne… > Annetaan varmenteelle 

nimi ja OK 

4. Sivustot > Hiiren oikealla Default Web Site > Sidonnat… 

Lisätään sivun sidontoihin http- ja https-portit. Aiemmin luotua varmennetta tarvi-

taan https-portin sidonnan yhteydessä. 

5. Sivustot > Hiiren oikealla Default Web Site > Perusasetukset… 

Asetetaan fyysiseksi poluksi Red5-palvelimessa sijaitseva ROOT-kansio. 
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Yhteys nimellä… > Määritelty käyttäjä > Määritä > Aseta käyttäjänimeksi ”IUSR” 

ja jätä salasana tyhjäksi > OK. 

4.5 Palvelimen käynnistäminen 

Red5-palvelin käynnistettiin juurihakemistossa sijaitsevasta red5.bat-tiedostosta. IIS-

palvelin käynnistettiin IIS-palveluiden hallinnasta. Tämän jälkeen Sovelluksen tulisi nä-

kyä selaimessa etäkoneen ip-osoitteessa. Mikäli yhteys ei toimi, kannattaa käynnistää 

uudelleen Red5- ja IIS-palvelimet.  

5 Jatkokehitys 

Jatkokehityksen tärkeimpänä tarkoituksena oli luoda uusi käyttöliittymä. Suurin osa muu-

toksista tapahtui clouds.js-nimisessä javascript-tiedostossa. Muihin jatkokehityksen teh-

täviin kuului verkkokaupan luonti sekä tietokantojen yhdistäminen. 

5.1 Käyttöliittymä 

Vanhassa näkymässä tarinat kulkivat jonossa. Ongelma vanhassa näkymässä tuli esille 

tarinoiden lisääntyessä. Kaikki tarinat kulkivat yhdessä kasassa, eikä eri vuosien tari-

noilla ollut selkeää erottelua.  Tiettyyn vuoteen päästäkseen saattoi joutua etenemään 

aikajanalla pitkään. 
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Kuva 4 Vanha näkymä 

Uudessa näkymässä viidestä lähimmästä tarinasta näytetään esikatselukuva tarinan si-

sällöstä ja keskimmäinen tarina on suurennettu. Vanhemmat tarinat on lajiteltu vuoden 

perusteella omille riveille. Mikäli samalla vuodella on paljon tarinoita, niin tietyn rajan 

ylimenevät tarinat muuttuvat läpinäkyviksi ja lopulta näkymättömiksi. Mitä kauempana 

tarinat ovat, sitä läpinäkyvämmäksi ne muuttuvat. 

3D-objektit ja ankkuritarinat (esim. tärkeä tapahtuma kyseisenä vuotena) näytettiin erik-

seen vasemmalla omalla kaistallaan. Vanhassa näkymässä nämä objektit kulkivat muit-

ten tarinoiden joukossa. 
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Kuva 5 Uusi näkymä 

Uuteen näkymään tehtiin uusi vierityspalkki, joka skaalautui näytön mukaan. Vierityspal-

kissa näytettiin myös kunkin tarinarivin vuosiluvut. 

5.2 Koodi muutokset 

5.2.1 Clouds.js 

Näkymä luotiin javascript-tiedostossa, jossa käytettiin WebGL-kirjastoa grafiikoiden 

luontiin. Vanhassa versiossa kameran positiota liikutettiin pitkin linjaa, jolle tarinat oli ase-

tettu. Logiikan muuttaminen osoittautui hankalaksi vanhan koodin päälle. Poistin suuren 

osan vanhasta koodista ja vaihdoin logiikkaa, jolla näkymä toimii. Uudessa versiossa 

kamera pysyy paikoillaan ja tarinoiden sijaintia muutetaan. 
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Kuva 6 Lasketaan eri vuosien lukumäärät 

 

Kuvan 6 esimerkissä tarina-objekteihin lisätään muuttuja, jossa on lukumäärä tarinoista, 

joissa on sama vuosi.  Tätä muuttujaa käytetään, jotta saadaan asetettua taustalla olevat 

tarinat oikeisiin paikkoihin. Laskuista jätettiin pois etuosan tarinat, koska niissä saattoi 

olla eri vuosien tarinoita. 
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Kuva 7 Lasketaan tarinoiden sijainti 

 

Tarinat lajiteltiin vuosien mukaan riveihin. Mitä suurempi ero etuosan tarinan vuodesta, 

sitä ylemmäksi sekä kauemmaksi tarinat asetettiin näkymään. Tarinat järjestetään kes-

kitetysti näytölle. Reunojen ylimenevät tarinat muuttuvat näkymättömiksi. Kaukana nä-

kyvät tarinat muuttuvat läpinäkyviksi, jotta näyttäisi, että tarinat katoavat sumuun. 

 

 

Kuva 8 Etuosan tarinat suurennetaan 
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Kuvassa 8 muutetaan etuosan tarinaobjektien kokoa ja sijaintia. Normaalinäkymässä 

etuosan tarinoita on viisi, mutta kuvasuhteesta riippuen tarinoita voi olla myös kolme tai 

yksi. Kaikkia näitä tarinoita suurennetaan, mutta keskimmäinen tarina on suurennettu 

muista isommaksi. Tarina-komponenttien kokoa pystyi muuttamaan admin-työkaluilla 

jQuery:n DOM-muuttujien avulla. [6.] 

 

 

Kuva 9 Esikatselukuvien lataaminen 

 

Kuvassa 9 on esimerkki tarinaobjektin tekstuurin muutoksesta. Lähellä oleviin tarinoihin 

lisättiin esikatselukuva, mikäli tarinasta löytyi kuva joltakin sivulta. Muutoin esikatseluku-

vaksi asetetaan tarinan tyyppiä kuvaava kuva, jotka olivat teksti-, audio- sekä videota-

rina. Kuvatarinoista löytyi aina kuva, joten niitä ei tarvinnut lisätä. 
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Kuva 10 Objektien luontifunktio 

 

Etuosan tarinoita varten luotiin kehykset käyttäen kuvan 10 renderObject-funktiota. Kai-

kissa kehyksissä oli valkoiset reunat. Vasemmilla olevissa kehyksissä oli tumma linssi ja 

oikealla vaalea linssi joiden läpi näkyi esikatselukuva. Keskimmäisessä kehyksessä suu-

rin osa esikatseluvasta näkyi selkeästi, mutta kehyksen alareunassa oli pieni tummen-

nettu osio, johon päivämäärä oli asetettu. Tarinan otsikko nostettiin ylös, jolloin se ei 

enää ollut esikatselukuvan päällä. 
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Kuva 11 Tarinaobjektin värin muutos 

 

Kuvassa 11 tarinaobjektin väri muuttui vaalean sinertäväksi, kun kursoria pidettiin sen 

päällä. Muussa tapauksessa tarinaobjekti palautettiin alkuperäiseen väriin. Vasemman-

puoleisissa etuosan teksteissä käytettiin valkoista väriä, kun taas oikeanpuoleisissa 

mustaa. Keskimmäisen tarinaobjektin otsikon väri oli musta ja päivämäärä valkoinen. 

Värit olivat erilaiset, koska niitten tuli näkyä hyvin aiemmin mainittujen kehyksien päällä.  
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5.2.2 Genericpage.tag 

Genericpage.tag-niminen tiedosto sisälsi ylä- ja alatunnisteen sisällöt, jotka näkyivät 

aina huolimatta siitä, mikä palvelun sivuista oli auki. Sivun taustakuva määriteltiin myös 

tässä tiedostossa. 

 

Kuva 12 Taustakuvan vaihto JSTL:llä 

Taustakuva sekä ylä- ja aulatunnisteen tausta vaihtuivat erilaiseksi, mikäli käyttäjä oli 

kirjautuneena palveluun. Istunnon tarkistamiseen käytetään JSTL:ää (JavaServer Pages 

Standard Tag Library), kuten kuvassa 12. [5.] 

5.2.3 Home.jsp 

Home.jsp-tiedostossa määriteltiin aikajananäkymä, joka oli myös ensimmäisenä au-

keava perusnäkymä.  Tiedosto sisälsi vierityspalkin, jota liikuttamalla näkymän vuosilu-

kua muutettiin. Sivun oikeaan luotiin välilehdet, joista pääsi muuttamaan näkymää aika-

jananäkymän ja karttanäkymän välillä.  
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Kuva 13 Skaalautuvat painonapit 

 

Sivun laidassa olevat välilehdet sekä vierityspalkki skaalautuvat ikkunan koon suhteen. 

Skaalautuva tyyli saadaan aikaan käyttäen viewport-yksiköitä vh ja vw. [7.] Muut div-

osioiden ominaisuudet määritellään erillisessä css-tiedostossa, kuten kuvan 14 esimer-

kissä. 

 

 

Kuva 14 navkartta css-tyyli 

5.2.4 Muut muutokset 

mapView.jsp-tiedostossa määriteltiin karttanäkymä. Tarina objektit sijoitettiin Google-

Maps:n kartalle. Koodi muutokset tähän tiedostoon olivat samanlaisia kuin aikanäky-

mässä. Karttanäkymän vierityspalkki toimi zoomaus-toimintona vuosien sijasta. 
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Kuva 15 Vierityspalkin css-tyyli 

Sivuston tyylit saatettiin määritellä useassa eri paikassa, mutta suurin osa tyyleistä mää-

riteltiin Style.css-tiedostossa. ”!important”-merkinnällä varmistetaan, että kyseistä omi-

naisuutta käytetään, mikäli kyseiselle kohdalle on olemassa useita tyylivaihtoehtoja. 

 

Kuva 16 Alatunnisteen css-tyyli 

 

Ylä- ja alatunnisteen taustoja monistetaan background-repeat-muuttujalla. Käytetty kuva 

oli hyvin ohut, jota sitten monistettiin vaakasuunnassa repeat-x muuttujan avulla, kuten 

kuvan 16 esimerkissä. 
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5.3 Verkkokauppa 

Verkkokaupan ohjelmointi jäi kesken, mutta sain tehtyä jonkinlaisen pohjan verkkokau-

palle. Tutustuin myös Paytrail-maksupalvelun toimintaan. 

 

Kuva 17 Ostettava tuote 

 

Tuotevalikon ohjelmoinnissa käytettiin bootstrap-kehystä. Kuvan 17 koodiesimerkin pai-

nonappiin ei ole lisätty vielä Paytrail-linkkiä. 

Maksun suorittamiseen käytetään Paytrail-verkkomaksupalvelua. Paytrail on suomalai-

nen maksulaitos, joka kuuluu osaksi pohjoismaista Nets-perhettä.  

 Paytrail valittiin maksutavaksi koska se sisältää suuren valikoiman maksutapoja. Se si-

sältää kaikkien kotimaisten pankkien verkkomaksupainikkeet, joihin kuukuu: Nordea, 

Osuuspankki, Danske Bank, Säästöpankki, Oma Säästöpankki, POP Pankki, Aktia, 

Handelsbanken, Ålandsbanken ja S-Pankki, sekä korttimaksu palveluita: Visa, Visa 

Electron, Mastercard, American Express, Eurocard, Diners Club ja JCB. Suurin osa pal-

velumme käyttäjistä on suomalaisia, joten kotimaisuus oli myös yksi peruste verkkomak-

supalvelun valintaan, sillä se lisää luotettavuutta. 

Maksupainike määriteltiin kuvan 18 mukaisesti. [3.] Nappia painamalla käyttäjä siirtyi 

Paytrailin sivulle, jossa maksu voitiin suorittaa. Maksun jälkeen käyttäjä siirtyi lomak-

keessa määritetylle paluusivulle tai maksun peruutussivulle. Maksutapahtuman toimin-

nan kannalta tärkein muuttuja on AUTHCODE, eli koodi joka todistaa maksutapahtuman 

oikeaksi. 
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Kuva 18 Paytrail maksupainikkeen esimerkki 

 

AUTHCODE saatiin käyttämällä md5 Hash kääntäjää. [4.] Kääntäjään syötettiin merkki-

jono, joka koostui kauppiassalaisuudesta (merchant secret) mikä oli Paytrail:ltä saatu 

henkilökohtainen koodi, joka yhdisti maksutapahtuman omaan tiliin, sekä lomakkeessa 

olevista arvoista, jotka oli erotettu pysty viivalla. Koodin kirjaimet piti muuttaa isoiksi, jotta 

linkki toimisi.  

 

 

Kuva 19 MD5 Hash kääntäjä 

 

Painiketta painettaessa siirrytään Paytrailin sivulle. Tällä sivulla näkyy maksun saaja, 

tilausnumero sekä maksun summa. Sivulla tulee valita maksutapa, jonka jälkeen siirry-

tään valitsemasi verkkopankin sivulle maksamaan tilausta. 
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Kuva 20 Paytrailin maksutapahtuma 

 

Maksun jälkeen siirrytään takaisin lomakkeessa määritetylle paluusivulle. Tilauksen tie-

dot näkyvät URL:issa kyselyinä (Query String). 

 

5.4 Tietokantojen yhdistäminen 

Palvelusta oli olemassa kaksi eri versiota. Vanhempi versio sisälsi tarinoita, jotka oli tar-

koitus siirtää uuteen versioon. Tietokannat kuitenkin erosivat hiukan toisistaan ja tiedos-

toilla saattoi olla sama id, joka aiheutti ongelmia. 

 

Kuva 21 MySQL-tietokannan ID-muunnos 

Tietokantojen id:ien ollessa samoja kasvatettiin niitten arvoa riittävän suuresti kuvan 21 

kaltaisella lauseella. 
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Kuva 22 MySQL-tietokannan kopioiminen 

 

Kuvan 22 ”Data Export” toiminnolla tietokannasta voitiin luoda sql-tiedosto. Ennen tieto-

kantojen yhdistämistä alkuperäisestä tietokannasta otettiin talteen sql-tiedosto, jotta tie-

tokanta voidaan palauttaa vahingon sattuessa.  

 

Lisättävästä tietokannasta otettiin vain data valitsemalla ”Dump Data Only”. Valitsemalla 

”Export to Dump Project Folder” tietokannan jokaisesta taulukosta luotiin erikseen omat 

tiedostot kansioon. Tämä vaihtoehto saatettiin valita, mikäli kaikkia taulukoita ei haluttu 

lisätä. Tietokanta voitiin tallentaa kokonaisuudessaan yhteen tiedostoon valitsemalla 

”Export to Self Contained File”. Ajan säästämiseksi käytettiin tätä vaihtoehtoa. Tästä 

luotu skriptitiedosto ajettiin alkuperäisessä tietokannassa.  
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6 Yhteenveto 

Tavoitteena oli luoda uusi käyttöliittymä sekä verkkokauppa sovellukselle. Sain luotua 

uuden käyttöliittymän. Uutta versiota ei ole kuitenkaan vielä viety julkiseen versioon muu-

tamien skaalauksesta aiheutuvien bugien vuoksi. Verkkokaupan ohjelmointi jäi kesken, 

mutta sain tehtyä alustavaa suunnittelua jatkoa varten. 

Työn aikana opin pystyttämään pilvipalvelun, käsittelemään tietokantoja sekä tekemään 

skaalautuvia web-sivuja. Kehityin toisen tekemän koodin tulkitsemisessa ja bugien etsi-

misessä.  

Ohjelman kehitystä tullaan jatkamaan tämän dokumentoinnin jälkeen. Tämä opinnäyte-

työ toimii myös ohjeena palvelun kehittämistä jatkaville henkilöille. Jatkokehityksessä 

tullaan keskittymään verkkosovelluksen kaupallistamiseen ja käytettävyyden parantami-

seen. 

Työskentely tämän sovelluksen parissa vaatii kykyä tulkita toisten tekemää koodia sekä 

kykyä työskennellä itsenäisesti. Sovelluksen toimintaan tutustuminen saattaa viedä jon-

kin verran aikaa, mutta työskentely on joustavaa. 

 

 

 

 



 

  26 (26) 

 

  

Lähteet 

1 Auvinen, Risto. 2016. Verkkosovelluksen jatkokehitys. Insinöörityö. Metropolia 
Ammattikorkeakoulu. 

2 Lähteenmaa, Juha. 2016. Verkkosovelluksen ohjelmistoteknologiat. Insinöörityö. 
Metropolia Ammattikorkeakoulu. 

3 Paytrail – Integration guide. Verkkodokumentti. http://docs.paytrail.com/en/in-
dex.html. Luettu 14.8.2017  

4 md5 Hash Generator. Verkkodokumentti. http://www.mira-
clesalad.com/webtools/md5.php. Luettu 14.8.2017 

5 JSP – Standrad Tag Library (JSTL) Tutorial. Verkkodokumentti. https://www.tuto-
rialspoint.com/jsp/jsp_standard_tag_library.html. Luettu 14.8.2017 

6 jQuery Tutorial. Verkkodokumentti. https://www.w3schools.com/jquery/de-
fault.asp. Luettu 14.8.2017 

7 CSS Units. Verkkodokumentti. https://www.w3schools.com/cssref/css_units.asp. 
Luettu 14.8.20 


